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NI-IMAQdx	gives	you	the	ability	to	acquire	images	with	gigabit	ethernet	(GigE)	cameras	and
industrial	IEEE	1394	digital	video	cameras.	The	cameras	may	operate	at	various	resolutions	and
frame	rates,	depending	on	camera	capabilities.	This	help	file	explains	how	to	configure	the	NI-
IMAQdx	driver	software,	gigabit	ethernet	cameras,	and	IEEE	1394	cameras	using	Measurement
&	Automation	Explorer	(MAX).	You	can	use	MAX	to	perform	the	following	operations:

Configure	the	device	attributes
Display	a	histogram	to	help	configure	the	device
Perform	snap	and	grab	image	acquisitions	for	diagnostics	and	verification
Save	acquired	images	as	bitmap	(BMP),	tagged	image	file	(TIFF),	or	Portable	Network
Graphic	(PNG)	files

For	more	information	about	this	help	file,	refer	to	the	following	topics:

Using	Help

Related	Documentation

Important	Information

Technical	Support	and	Professional	Services

To	comment	on	National	Instruments	documentation,	refer	to	the	National	Instruments	Web	site.

©	2006–2008	National	Instruments	Corporation.	All	rights	reserved.
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Related	Documentation
Some	NI-IMAQdx	documents	also	are	available	as	PDFs.	You	must	have
Adobe	Reader	with	Search	and	Accessibility	5.0.5	or	later	installed	to
view	the	PDFs.	Refer	to	the	Adobe	Systems	Incorporated	Web	site	at
www.adobe.com	to	download	Adobe	Reader.	Refer	to	the	National
Instruments	Product	Manuals	Library	at	ni.com/manuals	for	updated
documentation	resources.
The	following	documents	contain	information	that	you	may	find	helpful	as
you	use	this	help	file:

NI	Vision	Acquisition	Software	Release	Notes—Contains
information	about	new	functionality,	minimum	system
requirements,	and	installation	instructions	for	NI-IMAQdx	driver
software.
NI-IMAQdx	VI	Reference	Help—Contains	reference	information
about	the	LabVIEW	palettes	and	VIs	for	NI-IMAQdx	driver
software.
NI-IMAQdx	Function	Reference	Help—Contains	reference
information	about	the	LabWindows/CVI	functions	for	NI-IMAQdx
driver	software.
NI-IMAQdx	Help—Contains	fundamental	programming	concepts
for	NI-IMAQdx	driver	software.
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Using	Help
Conventions
Navigating	Help
Searching	Help
Printing	Help	File	Topics



Conventions
This	help	file	uses	the	following	formatting	and	typographical
conventions:

» The	»	symbol	leads	you	through	nested	menu	items	and
dialog	box	options	to	a	final	action.	The	sequence	File»Page
Setup»Options	directs	you	to	pull	down	the	File	menu,
select	the	Page	Setup	item,	and	select	Options	from	the	last
dialog	box.
This	icon	denotes	a	tip,	which	alerts	you	to	advisory
information.
This	icon	denotes	a	note,	which	alerts	you	to	important
information.
This	icon	denotes	a	caution,	which	advises	you	of
precautions	to	take	to	avoid	injury,	data	loss,	or	a	system
crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	in	the
software,	such	as	menu	items	and	dialog	box	options.	Bold
text	also	denotes	parameter	names.

dark	red Text	in	this	color	denotes	a	caution.
green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,

help	file,	or	Web	address.
italic Italic	text	denotes	variables,	emphasis,	cross-references,	or

an	introduction	to	a	key	concept.	Italic	text	also	denotes	text
that	is	a	placeholder	for	a	word	or	value	that	you	must
supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should
enter	from	the	keyboard,	sections	of	code,	programming
examples,	and	syntax	examples.	This	font	is	also	used	for
the	proper	names	of	disk	drives,	paths,	directories,
programs,	subprograms,	subroutines,	device	names,
functions,	operations,	variables,	filenames,	and	extensions.



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window	or	use	the	following	toolbar	buttons	located	above
the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents
tab,	allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the
Back	button.
Options—Displays	a	list	of	commands	and	viewing	options	for
the	help	file.



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help
file.	If	you	want	to	search	for	words	in	a	certain	order,	such	as	"related
documentation,"	add	quotation	marks	around	the	search	words	as	shown
in	the	example.	Searching	for	terms	on	the	Search	tab	allows	you	to
quickly	locate	specific	information	and	information	in	topics	that	are	not
included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.
Use	the	asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For
example,	a	search	for	"prog*"	lists	topics	that	contain	the	words
"program,"	"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a
search	term.	For	example,	"?ext"	lists	topics	that	contain	the	words
"next,"	"text,"	and	so	on.

Note		Wildcard	searching	will	not	work	on	Simplified	Chinese,
Traditional	Chinese,	Japanese,	and	Korean	systems.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.
You	can	use	Boolean	expressions	and	wildcards	in	a	nested	expression.
For	example,	"example	AND	(program	OR	VI)"	lists	topics	that	contain
"example	program"	or	"example	VI."	You	cannot	nest	expressions	more
than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both	search	terms.
You	do	not	need	to	specify	this	operator	unless	you	are	using
nested	expressions.
OR—Returns	topics	that	contain	either	the	first	or	second	term.
NOT—Returns	topics	that	contain	the	first	term	without	the
second	term.
NEAR—Returns	topics	that	contain	both	terms	within	eight	words
of	each	other.



Search	Options

Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:
Search	previous	results—Narrows	the	results	from	a	search
that	returned	too	many	topics.	You	must	remove	the	checkmark
from	this	checkbox	to	search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that
contain	words	similar	to	the	search	terms.	For	example,	a	search
for	"program"	lists	topics	that	include	the	words	"programs,"
"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents
tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics

dialog	box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print
the	single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF
documents,	click	the	print	button	located	on	the	Adobe	Acrobat	Viewer
toolbar.



Connecting	the	Camera
You	can	connect	a	camera	to	a	local	Windows	machine	or	a	LabVIEW	Real-Time	target	machine.

Note		Before	you	connect	a	camera,	make	sure	the	hardware	and	NI-IMAQdx	software	is	installed.



Local	Connection
Complete	the	following	steps	to	connect	a	GigE	camera	or	an	IEEE	1394	camera	to	a	local
Windows	machine:

1.	 Connect	the	camera	to	the	port	on	the	local	machine.
2.	 In	the	MAX	configuration	tree,	expand	Devices	and	Interfaces	to	obtain	a	list	of

installed	devices.
3.	 Expand	NI-IMAQdx	Devices	to	obtain	a	list	of	available	cameras.

Note		If	an	IEEE	1394	camera	fails	to	initialize	as	an	IEEE
1394	digital	camera,	a	warning	dialog	box	opens,	and	a	red
circle	with	a	white	X	appears	next	to	the	camera.	To
configure	the	camera	as	an	IEEE	1394	digital	camera,
right-click	the	camera	and	select	Driver»NI-IMAQdx	IIDC
Digital	Camera.

4.	 Select	the	appropriate	camera	from	the	list.



Remote	Connection
Complete	the	following	steps	to	connect	an	IEEE	1394	camera	to	a	LabVIEW	Real-Time	target
machine:

1.	 Connect	the	camera	to	the	IEEE	1394	port	on	the	real-time	(RT)	target	machine.
2.	 In	the	MAX	configuration	tree,	expand	Remote	Systems.	A	short	delay	occurs	while

MAX	locates	all	the	remote	devices.
3.	 Expand	the	remote	device	you	want	to	target.	If	the	device	is	not	configured,	refer	to	the

MAX	Remote	Systems	Help	topics	(Help»MAX	Help)	for	information	about	adding	a
remote	device.

4.	 Expand	Software.	Confirm	that	the	NI-IMAQdx	RT	software	is	installed	on	the	remote
device.

5.	 If	the	NI-IMAQdx	RT	software	is	not	installed,	complete	the	following	steps	to	install	the
software:

a.	 Click	Software.
b.	 Click	Install	Software	on	the	MAX	toolbar	to	launch	the	LabVIEW	Real-Time

Install	Wizard.
c.	 Select	NI-IMAQdx	RT,	as	well	as	any	additional	software	you	would	like	to

install	on	the	target	machine.
d.	 Click	Next.	Review	the	list	of	software	you	selected	to	install.
e.	 Click	Next	to	begin	downloading	the	software	to	the	target	machine.	When

MAX	has	finished	downloading	the	software,	it	restarts	the	remote	device.
f.	 Click	Finish.
g.	 Press	<F5>	to	refresh	the	MAX	configuration	tree.	Your	IEEE	1394	camera

should	be	listed	under	the	Remote	Systems	branch.
6.	 Expand	Devices	and	Interfaces.
7.	 Expand	NI-IMAQdx	Devices	to	obtain	a	list	of	available	cameras.	If	the	NI-IMAQdx

Devices	folder	is	not	present,	the	NI-IMAQdx	software	failed	to	initialize.
8.	 Select	the	appropriate	camera	from	the	list.
Note		When	you	connect	a	new	device	to	a	local	or	remote	system,	press	the	<F5>	key	to	refresh	the	configuration	tree
and	update	the	list	of	cameras	in	the	NI-IMAQdx	Devices	folder.



Configuring	the	Camera
When	the	camera	is	successfully	connected,	you	can	configure	the	camera	in	MAX	to	perform
acquisitions.

Complete	the	following	steps	to	configure	the	camera	for	a	snap	acquisition:

1.	 Connect	the	camera	to	the	port	on	the	computer.
2.	 In	the	MAX	configuration	tree,	expand	Devices	and	Interfaces	to	obtain	a	list	of

installed	devices.
3.	 Expand	NI-IMAQdx	Devices	to	obtain	a	list	of	available	cameras.
4.	 Click	the	camera	name	to	select	the	appropriate	camera.
5.	 Click	Snap	to	acquire	a	single	image.

Tip		Click	Grab	to	acquire	images	continuously	while
focusing	the	camera.	Click	Grab	again	to	stop	the
acquisition.

6.	 Use	the	Acquisition	Parameters	and	Camera	Attributes	tabs	to	modify	the	camera
video	parameters.

7.	 Click	Snap	after	adjusting	the	parameters	to	view	how	these	changes	affect	the	image.
8.	 Click	Save	to	save	the	current	configuration.	These	settings	become	the	default	settings

for	the	camera.



Setting	Remote	Image	Options
When	performing	a	snap	or	grab	from	a	remote	system,	images	are	transferred	across	the
network	and	displayed	on	your	local	machine.

Complete	the	following	steps	to	balance	network	performance	and	image	quality.

1.	 Select	Tools»NI	Vision»Remote	Image	Options.
2.	 Select	Transfer	images	from	remote	target	to	local	host.
3.	 Select	Compress	images	before	transfer.
4.	 Adjust	the	image	quality	slider	as	shown	in	the	following	figure.

5.	 Select	Display	images	on	remote	monitor.
6.	 Set	Timeout	to	60,000	ms.



Transfer
Select	the	Transfer	images	from	remote	target	to	local	host	checkbox	to	display	images	in	the
MAX	window.	Clear	the	checkbox	to	disable	image	transfer.	Select	the	Compress	images	before
transfer	checkbox	to	perform	lossy	JPEG	compression.	Adjust	the	quality	slider	to	set	the	JPEG
compression	rate.	Higher	quality	images	take	longer	to	transfer.	This	option	is	useful	if	you	are
unable	to	transfer	images	at	full	frame	rate.	Clear	the	checkbox	to	transfer	images	without
compression.	The	default	settings	are	Transfer	selected,	Compress	selected,	and	moderate
compression.

Note		Changes	to	the	default	compression	and	image	quality	settings	remain	on	the	remote	target	until	you	reboot	the
target	or	programmatically	change	the	settings.



Display
Select	the	Display	images	on	remote	monitor	checkbox	to	display	the	image	on	the	remote
video	controller	in	the	default	video	mode.	Ensure	that	a	video	monitor	is	connected	the	remote
system.	Clear	the	checkbox	to	disable	the	display	on	the	remote	monitor.	By	default,	the	Display
checkbox	is	selected.

Note		Currently,	the	video	display	supports	only	Intel	i815	and	i845	graphics	chipsets.



Timeout
Specify	the	amount	of	time	for	the	local	host	to	wait	for	an	image	from	the	remote	target.	This
timeout	applies	only	to	transfers	from	the	remote	target	to	the	local	host.	The	default	is	60,000	ms,
or	1	minute.



Toolbar
The	toolbar	contains	the	following	buttons:

Save	commits	all	of	the	camera	configuration	parameters	and	stores	the	information	on
the	system	to	which	the	camera	is	connected.	This	button	is	disabled	if	none	of	the
parameters	have	changed.
Revert	returns	all	parameters	to	the	values	before	the	last	time	you	clicked	Save.

Note		The	Save	Changes?	dialog	box	opens	if	you	attempt
to	close	MAX	without	saving	the	parameter	changes.	If	you
do	not	save	the	changes,	the	camera	will	not	be	configured
as	expected.

Snap	performs	a	single-buffer,	single-shot	acquisition	and	displays	the	result	in	the	image
viewer.
Grab	performs	a	multiple-buffer,	continuous	acquisition	and	updates	the	image	viewer.
Click	Grab	again	to	stop	the	continuous	acquisition.

Note		Snap	and	Grab	use	the	latest	parameters	to	perform
an	acquisition,	allowing	you	to	preview	parameter	changes
before	saving	them	to	the	camera	file.

Histogram	displays	a	quantitative	distribution	of	the	pixels	in	the	most	recently	acquired
image	per	gray-level	value.	During	a	continuous	acquisition,	the	histogram	continuously
updates.
Save	Image	writes	the	most	recently	acquired	image	to	a	user-specified	location.
Show/Hide	Help	displays/hides	the	topic	and	context	sensitive	help	to	the	right	of	the
image	viewer.



Camera	Properties
Camera	Information	Tab

Acquisition	Attributes	Tab

Camera	Attributes	Tab

Bayer	Color	Tab

Ethernet	Attributes	Tab



Camera	Information	Tab
View	camera	properties	from	the	Camera	Information	tab.	This	information	is	also	reflected	in
the	MAX	configuration	tree.

Name	is	the	interface	name	used	to	open	the	camera	through	the	programming	interface.
Interface	names	are	assigned	by	the	driver.	The	first	attached	device	is	assigned	cam0.
Subsequent	devices	are	named	cam1,	cam2,	and	so	on.
Vendor	is	the	name	of	the	camera	manufacturer.
Model	is	the	model	name	of	the	camera.
Serial	Number	is	the	64-bit	unique	ID	of	the	camera.
Bus	Type	is	the	bus	type	of	the	camera.
IP	Address	is	the	IP	address	of	the	camera.



Acquisition	Attributes	Tab
Change	video	acquisition	parameters	from	the	Acquisition	Attributes	tab.

Video	Mode	displays	a	list	of	all	available	video	modes	for	the	camera.
Pixel	Format	displays	a	list	of	available	pixel	format	modes	for	the	camera.	Refer	to	the
camera	documentation	for	the	appropriate	pixel	formatting.
Speed	displays	a	list	of	available	transfer	speeds	for	the	camera.	The	default	is	400
Mbps.
Region	of	Interest	controls	the	acquisition	window	of	the	camera.	The	four	parameters
are	Left,	Top,	Width,	and	Height.	These	parameters	affect	the	amount	of	data	sent	across
the	bus	and	then	decoded	by	the	driver.
Timeout	sets	the	number	of	milliseconds	the	driver	waits	for	the	acquisition	to	complete
before	returning	a	timeout	error.	The	default	is	5,000	ms.
Packet	Size	specifies	the	number	of	bytes	transferred	in	each	data	packet.	Changes	to
this	parameter	affect	the	number	of	packets	required	to	transmit	an	image	over	the	bus.
Larger	values	transfer	images	faster.	Smaller	values	allow	more	cameras	to	coexist	on
the	same	bus.
Ignore	First	Frame	pauses	for	a	frame	interval	before	returning	an	image.	Set	this	option
if	a	snap	acquisition	returns	an	incorrectly	exposed	image.
Actual	Bit	Depth	specifies	the	number	of	bits	per	pixel	that	contain	image	information.
This	parameter	applies	only	to	images	with	16-bit	components.
Bit	Alignment	specifies	the	alignment	of	pixel	information	in	memory.	Refer	to	the
camera	specifications	for	the	correct	alignment.	The	default	is	Least	Significant	Bit	(LSB).
This	parameter	applies	only	to	images	with	16-bit	components.
Byte	Order	specifies	the	order	in	which	multibyte	data	is	stored.	Refer	to	your	camera
specifications	for	the	correct	byte	order.	The	default	is	Big	Endian.	This	parameter	applies
only	to	images	with	16-bit	components.



Camera	Attributes	Tab
View	and	modify	camera	attributes	from	the	Camera	Attributes	tab.	Use	the	toolbar	on	the
Camera	Attributes	tab	to	modify	the	appearance	of	the	attribute	tree	control.	The	toolbar	contains
the	following	buttons:

Expand	All/Collapse	All—Expands/collapses	all	of	the	subcategories	in	the	tree	control.
The	top-level	categories	are	always	expanded.
Refresh—Updates	all	of	the	attribute	values.	This	button	can	be	useful	for	updating	read-
only	attributes	while	an	acquisition	is	in	progress.
View	Options—Configures	the	view	options	of	the	attributes.

All	Attributes/Camera	Attributes—Displays	all	of	the	attributes	available	for	the
current	session	or	filters	all	of	the	attribute	categories	except	the	Camera
Attributes	category	in	the	tree	control.

Simple/Intermediate/Advanced—Specifies	the	visibility	of	the	attribute	to
display.	Only	attributes	with	the	specified	visibility	will	be	displayed.	Select
Advanced	to	return	all	the	visible	attributes.

Actual	Names/Display	Names—Displays	the	actual	or	display	names	of	the
attributes.	The	display	name	is	a	human	readable	version	of	the	actual	name.

Show	Help/Hide	Help—Displays/hides	the	tooltip	window	that	appears	at	the	bottom	of
the	tree	control.	This	window	is	used	to	display	helpful	information	about	the	selected
attribute	in	the	tree	control.



Bayer	Color	Tab
Change	Bayer	color	parameters	from	the	Bayer	Color	tab.

Bayer	Pattern	sets	the	variation	of	the	Bayer	encoder	pattern	used	to	encode	the	image.
Red	Gain	adjusts	the	red	gain	of	the	RGB	image.	The	default	is	1.000.
Green	Gain	adjusts	the	green	gain	of	the	RGB	image.	The	default	is	1.000.
Blue	Gain	adjusts	the	blue	gain	of	the	RGB	image.	The	default	is	1.000.
White	Level	sets	the	white	level	to	optimize	the	input	signal	range.	Monitor	the	image
histogram	to	choose	the	appropriate	white	offset	level.	The	white	level	is	programmable
in	the	range	of	0	to	255.	Higher	values	produce	brighter	images.	The	default	is	220.
Auto	Calculate	Gains	calculates	the	values	for	Red,	Green,	and	Blue	Gain.	Complete
the	following	steps	to	calculate	the	appropriate	gains:

1.	 Set	White	Level	to	the	desired	value.
2.	 Point	the	camera	at	a	predominately	white	object,	such	as	a	sheet	of	paper.
3.	 Click	Auto	Calculate	Gains.



Ethernet	Attributes	Tab
Change	ethernet	parameters	from	the	Ethernet	Attributes	tab.

Resends	Enabled	determines	if	resends	will	be	issued	for	missing	packets.
Max	Resends	Per	Packet	is	the	maximum	number	of	resend	requests	that	will	be	issued
for	a	missing	packet.
Memory	Window	Size	(KB)	is	the	window	size	to	use	for	packet	processing.
Resend	Threshold	Percentage	is	the	threshold	of	the	packet	processing	window	that
will	trigger	packets	to	be	resent.	The	threshold	is	expressed	as	a	percentage.
Missing	Packet	Timeout	(ms)	is	the	time	to	wait	for	a	missing	packet	before	issuing	a
resend.
New	Packet	Timeout	(ms)	is	the	time	to	wait	for	new	packets	to	arrive	in	a	partially
completed	image	before	assuming	the	rest	of	the	image	was	lost.
Resend	Response	Timeout	(ms)	is	the	time	to	wait	for	a	resend	request	to	be	satisfied
before	sending	another	request.
Resend	Timer	Resolution	(ms)	controls	the	resolution	of	the	packet	processing	system
that	is	used	for	all	packet-related	timeouts.
Resend	Packets	Requested	is	the	number	of	packets	that	have	been	requested	to	be
resent	in	the	current	acquisition.
Resend	Packets	Received	is	the	number	of	packets	that	have	been	requested.
Lost	Packet	Count	is	the	number	of	packets	that	have	been	lost	in	the	current
acquisition.



Important	Information
Warranty
Copyright
Trademarks
Patents
Warning	Regarding	Use	of	NI	Products



Warranty
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS	MAKES
NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND	SPECIFICALLY
DISCLAIMS	ANY	WARRANTY	OF	MERCHANTABILITY	OR	FITNESS
FOR	A	PARTICULAR	PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER
DAMAGES	CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE	AMOUNT
THERETOFORE	PAID	BY	THE	CUSTOMER.	NATIONAL
INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR	DAMAGES	RESULTING
FROM	LOSS	OF	DATA,	PROFITS,	USE	OF	PRODUCTS,	OR
INCIDENTAL	OR	CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF
THE	POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in
contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action



accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.
National	Instruments	respects	the	intellectual	property	of	others,	and	we
ask	our	users	to	do	the	same.	NI	software	is	protected	by	copyright	and
other	intellectual	property	laws.	Where	NI	software	may	be	used	to
reproduce	software	or	other	materials	belonging	to	others,	you	may	use
NI	software	only	to	reproduce	materials	that	you	may	reproduce	in
accordance	with	the	terms	of	any	applicable	license	or	other	legal
restriction.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,
Stateflow®,	and	xPC	TargetBox®	are	registered	trademarks,	and
TargetBox™	and	Target	Language	Compiler™	are	trademarks	of	The
MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
The	Bluetooth®	word	mark	is	a	registered	trademark	owned	by	the
Bluetooth	SIG,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.

javascript:WWW(WWW_Trademark)


Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file	on
your	media,	or	ni.com/patents.
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WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT	DESIGNED
WITH	COMPONENTS	AND	TESTING	FOR	A	LEVEL	OF	RELIABILITY
SUITABLE	FOR	USE	IN	OR	IN	CONNECTION	WITH	SURGICAL
IMPLANTS	OR	AS	CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT
SYSTEMS	WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,	RELIABILITY	OF
OPERATION	OF	THE	SOFTWARE	PRODUCTS	CAN	BE	IMPAIRED	BY
ADVERSE	FACTORS,	INCLUDING	BUT	NOT	LIMITED	TO
FLUCTUATIONS	IN	ELECTRICAL	POWER	SUPPLY,	COMPUTER
HARDWARE	MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN	APPLICATION,
INSTALLATION	ERRORS,	SOFTWARE	AND	HARDWARE
COMPATIBILITY	PROBLEMS,	MALFUNCTIONS	OR	FAILURES	OF
ELECTRONIC	MONITORING	OR	CONTROL	DEVICES,	TRANSIENT
FAILURES	OF	ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR	ERRORS	ON
THE	PART	OF	THE	USER	OR	APPLICATIONS	DESIGNER	(ADVERSE
FACTORS	SUCH	AS	THESE	ARE	HEREAFTER	COLLECTIVELY
TERMED	"SYSTEM	FAILURES").	ANY	APPLICATION	WHERE	A
SYSTEM	FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO
PROPERTY	OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY
INJURY	AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON	ONE
FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK	OF	SYSTEM
FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR	DEATH,	THE	USER	OR
APPLICATION	DESIGNER	MUST	TAKE	REASONABLY	PRUDENT
STEPS	TO	PROTECT	AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT
NOT	LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING	PLATFORMS
AND	BECAUSE	A	USER	OR	APPLICATION	DESIGNER	MAY	USE
NATIONAL	INSTRUMENTS	PRODUCTS	IN	COMBINATION	WITH
OTHER	PRODUCTS	IN	A	MANNER	NOT	EVALUATED	OR
CONTEMPLATED	BY	NATIONAL	INSTRUMENTS,	THE	USER	OR



APPLICATION	DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR
VERIFYING	AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL	INSTRUMENTS
PRODUCTS	ARE	INCORPORATED	IN	A	SYSTEM	OR	APPLICATION,
INCLUDING,	WITHOUT	LIMITATION,	THE	APPROPRIATE	DESIGN,
PROCESS	AND	SAFETY	LEVEL	OF	SUCH	SYSTEM	OR
APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	award-winning	National	Instruments
Web	site	at	ni.com	for	technical	support	and	professional	services:

Support—Technical	support	resources	at	ni.com/support	include
the	following:

Self-Help	Resources—For	answers	and	solutions,	visit
ni.com/support	for	software	drivers	and	updates,	a
searchable	KnowledgeBase,	product	manuals,	step-by-
step	troubleshooting	wizards,	thousands	of	example
programs,	tutorials,	application	notes,	instrument	drivers,
and	so	on.	Registered	users	also	receive	access	to	the	NI
Discussion	Forums	at	ni.com/forums.	NI	Applications
Engineers	make	sure	every	question	submitted	online
receives	an	answer.
Standard	Service	Program	Membership—This
program	entitles	members	to	direct	access	to	NI
Applications	Engineers	via	phone	and	email	for	one-to-
one	technical	support,	as	well	as	exclusive	access	to	on
demand	training	modules	via	the	Services	Resource
Center.	NI	offers	complementary	membership	for	a	full
year	after	purchase,	after	which	you	may	renew	to
continue	your	benefits.
For	information	about	other	technical	support	options	in
your	area,	visit	ni.com/services	or	contact	your	local	office
at	ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-
house	technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
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Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.



Branch	Offices
Office Telephone	Number
Australia 1800	300	800
Austria 43	662	457990-0
Belgium 32	(0)	2	757	0020
Brazil 55	11	3262	3599
Canada 800	433	3488
China 86	21	5050	9800
Czech	Republic 420	224	235	774
Denmark 45	45	76	26	00
Finland 358	(0)	9	725	72511
France 33	(0)	1	57	66	24	24
Germany 49	89	7413130
India 91	80	41190000
Israel 972	0	3	6393737
Italy 39	02	41309277
Japan 0120-527196	/	81	3	5472	2970
Korea 82	02	3451	3400
Lebanon 961	(0)	1	33	28	28
Malaysia 1800	887710
Mexico 01	800	010	0793
Netherlands 31	(0)	348	433	466
New	Zealand 0800	553	322
Norway 47	(0)	66	90	76	60
Poland 48	22	3390150
Portugal 351	210	311	210
Russia 7	495	783	6851
Singapore 1800	226	5886
Slovenia 386	3	425	42	00



South	Africa 27	0	11	805	8197
Spain 34	91	640	0085
Sweden 46	(0)	8	587	895	00
Switzerland 41	56	2005151
Taiwan 886	02	2377	2222
Thailand 662	278	6777
Turkey 90	212	279	3031
United	Kingdom 44	(0)	1635	523545
United	States	(Corporate) 512	683	0100
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